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SAP2000® Version 20.1.0 
Release Notes 

© Copyright Computers and Structures, Inc., 2018 

Notice Date: 2018-05-03 
 
 
This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 
Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 
 

Changes from v20.0.0 (Released 2017-12-18) 

Graphics 
Enhancements Implemented 

* Incident Description 
 78015 An enhancement was implemented to support multiple monitors when capturing images using 

the File menu > Capture Picture commands. 
 213408 DirectX graphics mode has been enhanced for better line quality and shading to improve the 

clarity of the model and better distinguish between edges and line objects, and to more clearly 
render symbols and text.   

Loading 
Enhancements Implemented 

* Incident Description 
 207093 An enhancement has been implemented to add the Singapore national annex for the auto-

seismic load pattern and response-spectrum function according to Eurocode 8-2004. 
* 212925 An enhancement has been implemented to add auto lateral loading per the NTC 2018 code. 

This includes auto wind, auto seismic, and the response-spectrum function. 

Analysis 
Enhancements Implemented 

* Incident Description 
* 42047 Linear time-history analysis can now be performed in the frequency domain, allowing the 

consideration of frequency-dependent properties, sub-systems, and/or boundary conditions 
represented by link elements. Loading is identical to that used for modal or direct-integration 
time-history analysis, and may be by ground acceleration or load patterns applied using one or 
more independent time-history functions. Damping is of the hysteretic type, and may be 
constant or vary with frequency. 

Frame Design 
Enhancements Implemented 

* Incident Description 
 101900 An enhancement was implemented to add more detailed output for Chinese 2010 concrete 

frame design. Specifically, the output now includes shear stresses from both the shear force and 
torsion, the total shear stress, and its comparison with the limit. Previously, only the shear stress 
from shear force was output even if there was significant torsion. 
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* Incident Description 
* 212396 An enhancement has been implemented, adding steel frame design according to the NTC 2018 

code. 
 212652 An enhancement was made in steel frame design according to the Chinese 2010 code in which 

additional parameters, namely the equivalent moment coefficients Beta_t and Beta_m, are now 
reported in the design details. This is a reporting change only. The results are unaffected. 

Results Display and Output 
Enhancements Implemented 

* Incident Description 
* 20965 

26037 
40977 
67817 
89276 

201510 
208097 

Strain response is now available for shell objects similar to stress response that was already 
available. Strains can be displayed graphically, in plot functions, in tables, and accessed using 
the API (Application Programming Interface). Strain components and principal values are 
presented in a one-for-one correspondence with the stress values. The strains reported are due 
to stress. Stress-free strains caused by temperature load, strain load, creep, and/or shrinkage are 
not included. Response is available for homogeneous and layered shells. 

 78561 An enhancement was made to report the joint forces for internal frame elements created for 
area and solid element edge constraints. They are reported as part of the frame joint forces table 
for selected area and solid objects.  

 84242 
208588 

An enhancement has been implemented to allow displaying either the min or the max soil 
pressure results. 

 208320 An enhancement was implemented to speed up calculation of enveloped response quantities of 
frame elements for nonlinear multi-stepped load cases and/or load combos. 

 208752 An enhancement was implemented in steel frame design codes Eurocode 3-2005 and NTC 
2008 in which a new columns for Mspan is added in the PMM design database table to report 
the Med,span moment. The Med,span was and still is reported in the design details window. 
This is a display change only. No calculations were changed. 

* 214318 Strain response is now available for solid objects similar to stress response that was already 
available. Strains can be displayed graphically, in plot functions, in tables, and accessed using 
the API (Application Programming Interface). Strain components and principal values are 
presented in a one-for-one correspondence with the stress values. The strains reported are due 
to stress. Stress-free strains caused by temperature load and strain load are not included. 

Database Tables 
Enhancements Implemented 

* Incident Description 
 206784 An enhancement has been implemented to provide a database table containing soil pressure 

results. These results were previously only available as a display. 

Data Files 
Enhancements Implemented 

* Incident Description 
 212218 An enhancement has been implemented to provide new section property libraries for AISC 15 

and ASTM A1085 steel sections. 
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Application Programming Interface 
Enhancements Implemented 

* Incident Description 
 99706 A change was made to consider multi-step External Results (user specified through the API) 

the same as multi-step nonlinear static case results for frame design purposes. This allows them 
to be designed step-by-step. Previously the frame design for these forces was based on 
enveloping results. 

 211953 An enhancement was implemented to provide API functions for getting and setting design 
preferences and overwrites for the Russian steel frame design code SP 16.13330.2011 and 
concrete frame design code SP 63.13330.2012. 

 212833 An enhancement was implemented to provide API functions for getting and setting Italian NTC 
2008 steel frame design preferences and overwrites. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 
* 208853 The version number has been changed to v20.1.0 for a new intermediate release. 

 

 

 

 
 
 
 
 

 

User Interface and Display 
Incidents Resolved 

* Incident Description 
 85713 An incident was resolved for two cases in which non-English characters were not correctly 

handled. 1) The name input on the Auto Select Section form did not allow the characters to be 
input. 2) The grid system bubbles did not correctly display certain characters. 

 95862 An incident was resolved where adding a display window when some parts of the structure 
were selected could in some cases cause the program to become unresponsive. 

 102335 An incident was resolved in which the program could terminate if a model window was 
undocked to a secondary monitor that had a height larger than the primary monitor. This was a 
rare condition. 

 208964 An incident was resolved where the program could crash if a mass source definition was 
deleted when it was in use within a load case. Now mass source definitions cannot be deleted 
when they are used by a load case. 

 208980 An incident was resolved in which the Edit > Replicate command would open multiple copies 
of the Replicate form if the command was used multiple times without closing the form. This 
was a user interface issue only. 
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* Incident Description 
 212154 

212696 
An incident was resolved where the parameters used to control target-force iteration were not 
available on the Nonlinear Parameters form when defining a nonlinear static or nonlinear 
staged-construction load case. These parameters could be changed using the interactive 
database editor. Even though the parameters were not available on the Nonlinear Parameters 
form, any values previously defined using the interactive database editor or from a model 
created in a previous version of the software would still apply. Newly created load cases would 
use default values. Results were consistent with the parameters visible in database table "Case - 
Static 4 - Nonlinear Parameters". This user-interface issue only affected v20.0.0. 

 212169 An incident was resolved where setting design overwrites to "Program Determined" while the 
user interface was translated into a language other than English would result in a warning 
message. This was a user interface issue only. 

 212558 
212603 

An incident was resolved where the software could terminate unexpectedly when clicking on 
the already open Set 2D View form (command View > Set 2D View) after performing a 
Replicate operation or other editing command that adds point objects to the model. No results 
were affected.  

Graphics 
Incidents Resolved 

* Incident Description 
 79358 

79359 
An incident was resolved where the rubber band zoom or rubber band selection in DirectX 
graphics mode was not working on some machines. 

 96456 An incident was resolved where the color of extruded areas in deformed shape plots was 
incorrect in certain cases. 

 101948 
203296 

An incident was resolved where area contours were not shown in 2D views in DirectX graphics 
if the area fill was also on. 

 201265 An incident was resolved where in DirectX graphics when contours were showing on deformed 
shapes the area element edges did not plot correctly. 

 203553 An incident was resolved where the contour plots of shell stresses showed some discontinuity 
when DirectX graphics was used. 

 203596 An incident was resolved in DirectX graphics where all joints were always being displayed 
even if located behind other objects.   

 207644 An incident was resolved in which the software could close unexpectedly when one of the 
model windows was closed while using DirectX graphics. 

 207697 
212304 

An incident was resolved where the extruded shape display for areas was not correct in DirectX 
graphics mode. The areas were shown as twice the actual thickness. This error was 
inadvertently introduced in v19. 

 209919 An incident was resolved where user was not able to set the color of the frames to pure black, 
instead the frames were shown in red. Other colors were possible. 

Drafting 
Incidents Resolved 

* Incident Description 
 208614 An incident was resolved in which replicating or mirroring joints that had the special joint 

option set to no, and no other objects were replicated or mirrored, would result in the new joints 
not being generated. This was a modeling issue only. 
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Modeling 
Incidents Resolved 

* Incident Description 
 208453 An incident was resolved where creation of the analysis model would generate illegal area 

element warnings for certain area objects to which general meshing was assigned. This was a 
rare occurrence and happened when the mesher incorrectly tried to create very small elements 
of the order of the merge tolerance. 

 208977 An incident was resolved where using the interactive database would remove previously 
assigned frame hinges even when working with tables that were not related to the hinge 
assignments. 

 209702 
211551 

An incident was resolved where models from a version prior to v20 that contained frame 
section properties from a section library (*.pro) with a section name containing lowercase 
letters would be reset to a general section if the model was edited through the interactive 
database or imported from a text file. Old models will be corrected when opened in v20.1.0. 

 212244 An incident was resolved for auto hinges using ASCE 41-13 where the program was adjusting 
the downward slope (between points C and D) of the backbone curve to avoid a vertical drop. 
This adjustment had a scaling error making it units dependent. Only the deformation at Point D 
was affected. The adjustment has been corrected. 

Loading 
Incidents Resolved 

* Incident Description 
 210085 An incident was resolved for ASCE 7-16 auto seismic load and response spectrum function 

where parameters Fa and Fv were not editable when Ss >= 1.0 and S1 > 0.2 sec for Soil 
Category E. Also, for ASCE 7-16 response spectrum function, parameters S1 and TL were not 
previously saved. 

* 210140 An incident was resolved where load patterns included in a staged construction load case but 
with a scale factor of zero could cause spurious loading to occur in a subsequent stage of the 
load case. This did not occur is the load pattern was omitted from the load case or applied with 
a negligible scale factor. When this occurred the effect on results was generally very obvious. 

Analysis 
Incidents Resolved 

* Incident Description 
 203968 An incident was resolved where the Change Modifiers and Change Releases operations were 

not being applied in a nonlinear staged-construction load case when all the following conditions 
were met simultaneously: 
(1) The nonlinear staged-construction load case did not have any applied loads in any of its 
stages, 
(2) The stage with the Change Modifiers/Releases operation had no Add, Remove, or Change 
Section operations specified, and 
(3) The stage with the Change Modifiers/Releases operation was either ((a) not the last stage of 
the load case, or (b) was the last stage and that stage had non-zero duration and time-dependent 
effects were being considered for the load case. 
When this issue occurred, the Change Modifiers/Releases operation was ignored for the 
affected stage or stages. 
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* Incident Description 
* 209069 

213129 
An incident was resolved where the temperature, strain, and deformation loads applied in a 
linear load case could, in some cases, be incorrect for certain objects in the model if the linear 
load case used the stiffness from the end of a nonlinear staged-construction load case. This 
error would not occur if the linear load case was run in a subsequent session from the preceding 
nonlinear staged-construction load case. A subsequent session would be anytime the software 
was restarted, the model was re-opened, or anytime the analysis was run in a separate process 
(command Analysis > Analyze > Analysis Options > Solver Options). This error was 
uncommon, model-dependent, and machine-dependent. When it occurred, the results were 
generally erratic and obviously incorrect. Temperature and strain loads are available for frame, 
shell, solid, asolid, and plane objects. Deformation loads are available for frame objects. Time-
dependent creep and shrinkage act as a strain load can could also affect frame and shell objects. 
This error could affect SAP2000 versions 17.1.0 to 20.0.0, although no incidents have been 
reported until recently (2018). 

* 211888 An incident was resolved where frame loads, including self-weight, could have been incorrectly 
applied during nonlinear load cases where the Geometric Nonlinear Parameters were set to "P-
Delta plus Large-Displacements". Load-case types that could be affected are nonlinear static, 
nonlinear staged construction, and nonlinear direct-integration time-history. This error only 
occurred when the number of threads used in the analysis procedure, which is reported in the 
.LOG file, was greater than 1. When this issue occurred, it created a discrepancy between the 
applied loading and computed results. In most cases this caused the analysis not to converge, 
and no results were available for the affected load cases. In some cases, the analysis would 
converge, and the results could then be incorrect. Only self-weight, gravity, concentrated-span 
and distributed-span loading applied to frames was affected. Temperature, strain, deformation, 
and target-force loads on frames were not affected. Loads on joints and other types of elements, 
including cables, were not affected. Nonlinear load cases with the Geometric Nonlinear 
Parameters set to "None" or "P-Delta" were not affected. This issue was present in SAP2000 
versions 19.1.0 to 20.0.0. Affected load cases in the affected versions should be re-run in the 
new version to check the results. 

 212118 An incident was resolved where nonlinear static load cases with zero load applied may fail to 
converge if starting from a previous load case. This issue may also occur in staged construction 
load cases during the instantaneous load application portion of a stage where no major stage 
operations (loads applied, objects added, or objects removed) have been defined. In this release, 
the following changes are made: 
(1) For nonlinear static load cases where no loads are applied, the relative iteration convergence 
tolerance will be determined relative to the total force present in the model. Normally the 
convergence tolerance is relative to the magnitude of the applied load, and that is still true when 
loads are applied, no matter how small. 
(2) In nonlinear staged construction load cases, a stage that does not have any major stage 
operations defined will skip the instantaneous load application portion of that stage during 
analysis if the stage has duration for time-dependent effects. For a stage with no major 
operations and no duration, iteration will be performed based on a convergence tolerance 
relative to the total force present in the model. 
When iteration is performed with tolerances relative to the total force in the model, most 
models will converge immediately or with just a few iterations that improve equilibrium. 
Changes in results from previous versions are expected to be small and within the specified 
convergence tolerance for well-conditioned models. 

 212654 An incident was resolved where a model having more than one Parametric PMM hinge was 
unable to run modal time history load cases (linear or nonlinear FNA) that used the modes from 
a Ritz or eigen modal load case that in turn used the stiffness from the end of a nonlinear static, 
staged-construction, or direct-integration time-history load case. When this error occurred, no 
results were available for the modal time history load case. No other results were affected. 
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Frame Design 
Incidents Resolved 

* Incident Description 
 101547 An incident was resolved for concrete column design based on the Chinese 2010 code where 

the P-M-M interaction diagram was using a compression cap factor of 1.0 instead of 0.9 for 
computing Pmax. Also, there was a slight inaccuracy from converting fyk to fy. 

 101592 An incident has been resolved for steel frame design using codes "AISC 360-05", AISC 360-
10", and "KBC 2009" in which the reported load combinations corresponding to the governing 
beam/column capacity ratios (BCCR) in tables and in the design details were incorrect. The 
reported design combination was always the last load combination in the list of considered 
combinations instead of the governing one. This was a reporting problem only. The BCCR 
values themselves were correct. 

 101901 An incident was resolved for concrete frame design using the Chinese 2010 code in which the 
calculation of λ (lambda) for columns was not correct for two reasons: (1) In the calculation of 
λ, the full depth of column was used instead of the effective depth h0. λ should be equal to 
M/(V*h0). (2) The program used the values of M and V after seismic modification 
magnification factors instead of using the unmodified values. The calculated λ values should 
not change with the overwrites of magnification factors for columns. This issue was only 
present for columns. The lambda values for beams are calculated based on the actual presence 
of a point load, if any. If there is no point load on beam, then λ is taken as 1.5. The calculation 
of λ for beams was not changed. 

 101903 An incident was resolved for Chinese 2010 concrete frame design where the concrete joint-
shear design Gamma_RE value of 0.75 was used instead of 0.85. Now the program uses the 
correct value of 0.85 and it reports it in the design details accordingly. 

 101907 An incident was resolved in the Chinese 2010 concrete frame design code for SDG=II the 
bottom rebar to top rebar ratio for beams was not ensured to be no less than 0.3 at supports. 
This issue was only present when the loading was low and the minimum required reinforcement 
for top rebar governed.  When the top rebar was based on actual loading this issue was not 
present and the required ratio for bottom rebar was enforced. 

 101908 An incident was resolved for concrete frame design using the Chinese 2010 code in which the 
calculation of the minimum rebar for columns was not correct. This affected only the concrete 
column design. This did not affect column checking and beam design. 

 202276 An incident has been resolved for beam flexure design in the Chinese 2010 steel frame design 
code in which the PhiB factors for tee and double-angle sections have been updated to consider 
the simplified formula for Lambda_y < 120*Sqrt(235/fy). The program has also been updated 
for PhiB factor calculation for both rolled and welded I-shaped members based on GB50017-
2018 App C equations App C.0.1-1 and App C.0.1-2 which covers both doubly- and singly-
symmetric I-shaped sections. The program has also been updated to consider bending stability 
of columns and braces in addition to the beams. In addition, the program allows overwriting 
PhiB.  

 202493 An incident has been resolved in the steel frame design code AISC 360-10 in which the right-
button click and the database report gave inconsistent error messages. This did not affect the 
demand/capacity ratio calculations. This was a reporting problem only. The design details 
window did not have any issue regarding this error message.  

 203781 An incident was resolved in aluminum frame codes AA-ASD 2000 and AA-LRFD 2000 in 
which some of the terms like Feb, Fcr, and Frb were being displayed as zeros for certain types 
of sections. These values were not calculated when not used. These values are now calculated 
and displayed even if not later used. This was a display issue only. 

 206924 An incident has been resolved for concrete frame design code Eurocode 2-2004 where the value 
of  Ec was being recomputed from material strength instead of using the value already provided 
by user as part of the material property. 
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* Incident Description 
 207430 An incident has been resolved in the steel frame design code AISC 360-10 in which the design 

details table erroneously showed a warning message stating that Fy is greater than 50 ksi for 
some elements, even though the Fy =36 ksi for those members.  This does not affect the 
demand/capacity ratio calculations. This is a reporting only problem. The design details 
window does not have any issue regarding this error message.  

 208699 An incident was resolved in steel frame design code AISC 360-10 in which the design details 
showed a warning stating that the section did not comply with F13.2, but the design summary 
table did not show any message. Now the summary table also shows the warning message. This 
was only a reporting issue. 

 209816 An incident was resolved in steel frame design codes Eurocode 3-2005, Italian NTC 2008, and 
Indian IS 800:2007 in which the PMM interaction ratio for section capacity check for 
rectangular hollow sections became very large (towards infinity) when the axial force ratio n, 
(n=Ned/Npl,Rd), became slightly larger than 0.9407 (n>1/sqrt(1.13)) but still less than 1.0. In 
this case the denominator of the expressions of Alpha and Beta became a very small negative 
number causing Alpha and Beta to be a very large negative number. The code does not specify 
any lower limit for Alpha and Beta. This very large negative number, when applied as powers 
for [My,Ed/Mn,y.Ed] and [Mz,Ed/Mn,z.Ed], produced incredibly large numbers. The problem 
has been resolved by putting a limit on n to be used in the expression. Effectively the limit of 6 
is applied on both Alpha and Beta. This issue was causing a problem in creating certain 
database tables for certain models. 

 212651 An incident was resolved for steel frame design according to the Chinese 2010 code in which 
the reporting of “Transfer Column” was not correct in the steel design details. It was always 
reported as “No” even if the overwrite “Is Transfer Column?” was set to “Yes”.  The overwrite 
item “Is Transfer Column?” is changed to “Is Transfer Member?”. The seismic modification 
factor was always taken as 1.0. Now it is taken as 1.5 if the member is a Transfer Member. 

Results Display and Output 
Incidents Resolved 

* Incident Description 
 206614 An incident was resolved where in certain rare cases when displaying reactions, the display 

would become unresponsive. This happened when the following path was taken: display 
reactions in tabular mode, unlock model, rerun analysis; the display would then freeze when 
trying to refresh the reactions display. 

 208754 An incident was resolved in which the right-click design details for Eurocode 3-2005, Italian 
NTC 2008, and Indian IS 800:2007 steel frame design always reported 'Envelopes' for the 
multi-response option used in the design, irrespective of the option selected in the design 
preferences. This was a reporting issue only and did not affect results. 

 214956 An incident was resolved where the display of the analysis and design results for nonlinear 
staged construction cases and linear cases using the stiffness of a nonlinear staged construction 
case in the model window could be slower than expected for larger models. This issue affected 
v19.2.0 to v20.0.0. 

Documentation 
Incidents Resolved 

* Incident Description 
 207880 An incident was resolved where the Eurocode 3-2005 steel frame design manual incorrectly 

documented in Chapter 2 that torsion design is not considered when it is considered for doubly-
symmetric I-shapes, box, and pipe shapes. 
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